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VEJLEDNING TIL PRINTUDLÆG 

 

 

 

 
 

Printplader er beregnet til at fastholde komponenter og skabe permanente forbindelser mellem dem. 

 

 

Eksempel på færdigt print: 

 
 

Processen benytter et specielt ” tegneprogram ” til at tegne øer, der passer til komponenterne, - og 

kobberbaner mellem de rigtige komponent-ben. ( IC-Pins ) 

 

Når printet skal fremstilles ”fysisk ” ætses kobberet væk, der hvor der ikke skal være forbindelser. 
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En printplade består af en plade af glasfiber, belagt med 

et antal kobberlag. Evt. på begge sider, eller endda med 

flere lag kobber nede i materialet.  

 

Det vi kan håndtere, er enkeltsidet print!! Dvs. kun med 

kobber på undersiden.  

 

Oversiden kaldes komponent-siden, og undersiden kan 

kaldes for – ” loddesiden ”. 

 

I programmet er lagene navngivet som vist her. 

 

Vi arbejder i Silketryklag S1 og Kobberlag C2.  

 

 

Man skal altid se på printet fra oversiden, - komponentsiden, Ikke noget med at tænke på spejling 

osv. Det sker automatisk i fremkaldning og ætsefasen.   

 

 

 

I Vores verden:  

 

Vore print består af en glasfiberplade. Den 

er belagt med et lag, der er kan ødelægges 

af UV -lys.  

 

Derfor er det dækket af et tykt lag sort 

plast.  
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I tegneprogrammet er der macroer, der 

passer til forskellige komponenttyper.  

 

Her har jeg lavet en macro med øer, 

der passer til ATMega328, med 

kobberbaner til krystallet, og pullup-

resistoren forbundet til reset-pinnen.  

 

Og der er vist, hvor der skal tilføres 5 

Volt og GND.  

 

( lavet for at hjælpe, då vi undgår for 

mange problemer med fejl i print, der 

både forsinker processen og koster !! ) 

 

 

 

 

Det røde lag kaldes Silketryk-laget. I den virkelige verden præges dette lag ovenpå den færdige 

printplade, så monteringsdamerne ??  kan se, hvor de forskellige komponenter skal sidde, - og 

vendes.  

 

Det bruger vi ikke, men vi kan jo printe det ud på papir ! 

 

Det er kun det grønne, vi skal bevare på vores printplade. Resten skal ætses væk.  

 

Her et par eksempler !! 
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Ovenfor ses et eksempel på et færdigt udlæg.  

 

Ovenfor til højre ses silketrykket, der kan 

bruges til at lodde efter. 

 

Til højre ses kobberbanerne på 

komponentsiden på det færdige print, men 

stadig set ovenfra. 
 

 

 

Hele opgaven går kort ud på at: 

 

Få tegnet et korrekt printudlæg 

Få den overført til et passende stykke printplade,  

Belysning med UV 

Fremkaldning,  

Ætsning,  

Fjernelse af laklaget, der beskytter kobberet mod syren. Den beskytter også mod loddetin!! 

Ny loddelak på. Den beskytter den rene kobber mod ilt, - men kan loddes på. 

Boring af huller 

Montering af komponenter og lodning. 

Test 

 

Procedure: 

 

For at fremstille et print til et kredsløb må man først have sit kredsløb til at fungere på et 

fumlebrædt.  

 

Der skal tegnes et Diagram:     fx med EasyEDA !!  Enormt let, og giver flotte diagrammer. Og har 

ALLE komponenter som macroer.  

 

I diagrammet skal der sættes ben-numre på alle komponenter. Det gør printudlæg meget nemmere !! 

 

Diagrammet tegnes fra venstre, og frem mod højre som kredsløbet logisk er opbygget.  

 

Næste step er at tegne printpladen i et stykke Print-software. Der findes flere, her bruges 

SprintLayout 6.0 fra Abacom Electronic Software  

 

 https://www.electronic-software-shop.com/?language=en 

 

 

I softwaren tegnes hvordan printpladen skal se ud. Dvs. hvor komponenterne er placeret i forhold til 

hinanden, og hvordan komponenterne er forbundet med hinanden med kobber-baner. 

Fra og til de rigtige pinnumre. 

 

Næste step er at overføre det tegnede print til selve printpladen. 

 

Det sker ved at printe udlægget ud på et klart ark. ( Sugende overhead )  

https://www.electronic-software-shop.com/?language=en
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Nu kan man så med en UV-belysningskasse overføre det til et passende stykke print, hvor dæklaget 

er fjernet.  

 

UV-lyset ødelægger lakken, men ikke der, hvor der er tegnet baner, Øer osv. 

 

Printet skal nu ” fremkaldes ”. I realiteten blot en proces hvor det ødelagte lak vaskes væk, så der 

kun er lak over de steder, hvor kobberet skal forblive på printpladen. 

 

Det kobber, der nu er blotlagt, skal ætses væk. Det tager ca. 15 til 20 minutter. Afhængig af syrens 

temperatur – og hvor slidt, den er ! 

 

Når printpladen er færdigætset, skal det vaskes af, og lakken på det blivende kobber skal væk vha. 

alm. sprit.  Man kan nemlig ikke lodde gennem denne lak. !! 

 

Men luftens ilt vil jo nu angribe kobberet, - så derfor påføres der et nyt lag lak, såkaldt loddelak. 

Det beskytter mod ilt, men kan loddes igennem. 

 

Herefter skal der bores huller, til komponent-ben – eller sokkel-ben, og sluttelig skal der monteres 

og loddes. 

 

 

SprintLayout 6.0 

 

 

Opsætning: 

 

Ved opstarten af programmet er der 

et par opsætninger, der kan være 

interessant. 

 

Vælg:  Options → General Settings  

→ Colors 

 

Her kan man vælge User 1, og evt. 

ændre baggrundsfarven.  

 
 

 

Vælg:  Options → General Settings  → Working Directories.  

 

Her kan man opsætte i hvilket bibliotek, man ønsker at gemme sine layout-filer.  

 

 

Makro-biblioteker 

 

 

Programmet kommer med biblioteker med færdige udlægsdele, fx til IC-huse.  

Derudover kan downloades et zippet bibliotek fra min hjemmeside. 
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Mappen skal placeres i User → Delte filer →  

Delte dokumenter → Layout60 → Makros 

 

SprintLayout-programmet skal genstartes før man kan ”se” 

de nye biblioteker.  

 
 

Updates: 

 

Updates til programmet kan hentes fra firmaets hjemmeside:  

Men plz. Dont !! 

 

Lidt om processen: 

 

Øverste side kaldes komponentsiden, hvor 

komponenterne placeres. Her kan der på rigtige 

printplader være trykt symboler, der skal hjælpe med at 

man kan få komponenterne placeret korrekt.  

 
 

Symbol-tegningerne kaldes ”Silketryk” efter en gammel teknik til at placere tekst og symboler på 

printplader. 

 

Undersiden kaldes C2, dvs. Kobber 2, og det er her, alle kobberbaner er. 

 

 

På oversiden kan der også være 

placeret printbaner, men kun hvis 

man har et ret komplekst print, og 

man arbejder med 2-sidet print.  

 

Det er noget mere besværligt at 

have med at gøre.  Kobberlaget på 

oversiden kaldes C1. 

 

 

På oversiden placeres komponenter 

og evt. lus.  ( Mærket 1 og 2. ) 

 

 

 

Undersiden kaldes C2 ( kobberside 2  ) 

 

Det er på undersiden, der skal være kobberbaner og hvor der loddes. 

 

I vores printudlægningsprogram er lagene altid nummereret set fra oven. 

Her er vist et andet eksempel. 



  Printudlæg  
 

Version 

11/5-2025 

 

/ Valle   Side 7 af 21 
 

 

Her er der tegnet et omrids på 

kobbersiden, så der kan klippes 

pænt efter ætsningen. Der er også 

markeret, hvor der skal bores til 

fastgøringsskruer. 

 

Placer en Ø der hvor der skal 

monteres skruer. Det er lettere at 

gøre ”pænt” på skærmen.  

 

Lav helst skruehul-øerne på 7 

mm. Det svarer til plast-afstands-

stykkernes diameter. 

 

 

 

I mit bibliotek er der nogle symboler, jeg plejer 

at bruge til at sætte i hjørnerne. 

 

De angiver både, hvor der senere skal klippes, 

og hvor meget afstandsstykkerne og skruer fyl-

der. 

 

 

 
 

 

 

 

 

 
 

Afstandsstykker er Ø 7 mm. 

 

Kilde: http://www.instructables.com/id/Creating-Printed-Circuit-Boards-with-a-INKJET-Prin/ 

 

 

Der kan sættes tekst på kobberlag C2. Det bliver automatisk spejlvendt. Herved kommer det til at 

stå retvendt set fra kobbersiden efter ætsningen. Teksten gør, at printet kan identificeres. 

http://www.instructables.com/id/Creating-Printed-Circuit-Boards-with-a-INKJET-Prin/
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I SprintLayout er der mulighed for at vælge hvilket lag, man arbejder i. Marker aktiv lag. 

 

 

 

 

C1   Eventuel øverste kobberlag. ( Komponentsiden ) 

S1   Øverste silketryk, 

C2   Nederste kobberlag. ( den, vi lægger printbaner i ) 

S2   Evt silketryk på undersiden. 

 

Herudover kan man klikke på C1, eller som her S1 for at slukke dette lag under tegningen. 

 

 

 

Bemærk, at baner sagtens kan gå under komponenter. 

 

 

 

 

Og at det ikke er forbudt at lave ”lus”. 

 

 

Den blå bane angiver, at der skal være 

en forbindelse på oversiden af printet. 

Tegnet i C1.  

 
 

 

Powersupply placeres så tæt på strømforbrugende dele som muligt! 

 

 
 

Når man tegner kobberbaner, er der visse regler: 
 

 Rigtig                        Undgå  
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Lav så bløde buer som muligt 

 

 

Undgå spidse vinkler, hvori der kan efterla-

des syre 

 

 

 

Lav så korte baner som muligt 

 

 

Udfyldt kobberareal er svær at varme op med 

en loddekolbe.  

 

 

. 

 

 

Se OK Tutorial: https://www.vthoroe.dk/Elektronik/Sprint/Sprint-Layout%206.0%20(EN).pdf     ( 86 sider )  

 

 

 

Grid 

 

 

Start altid med at vælge et grid på 2,54 mm. 

 

Det svarer til en 1/10 amerikansk tomme, som 

er afstanden på IC-ben i den størrelse kompo-

nenter, vi normalt bruger. 

 

 

 

 

https://www.vthoroe.dk/Elektronik/Sprint/Sprint-Layout%206.0%20(EN).pdf
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Board Størrelse 

 

I Properties kan man ændre et board-størrelse. Vælg den blot 

rigeligt stor.  

 

Det kan også gøres senere.  

 

Boards kan navngives.  

 

Der kan være flere Boards – Tabs i et design. 

 

Board > Add New Board.  
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Hent komponenter ind på tegnepladen.  

 

Evt. åben Macro-biblioteket: 

 
 

Her er der valgt at hente en DIL-18. 

 

Det er ikke selve komponenten, der hentes, men dens ”footprint”.  

 

Dvs. det kobber, der skal til for at man kan lodde en IC-Sokkel i 

printet, så der kan sættes en IC i. 

 

Eksempel på DIL-8 IC-Sokkel: 

 
Eksempel på Foot-print og IC.  

 
 

Nederst ses et outline af komponenten, eller af ”Macroen” 

 

Modstande hentes i User > Resistors,  

 

 
.  

Vælg RM10, dvs. 10 mm. som passer til en modstand. 

 

Brug   for at rotere en komponent 

 

 

 



  Printudlæg  
 

Version 

11/5-2025 

 

/ Valle   Side 12 af 21 
 

Nogle gange kan det ske, at en komponent ”mister” forbindelsen 

til dens grid. For at rette det, highlightes komponenten, og der 

trykkes på knappen    for at flytte den til nærmeste grid.  

Det kan ske, hvis man fx ændrer valgt Grid.  

 

 

 

Hentes en macro, kan man ”Disintegrate Component” 

Det gør det muligt at editere en sammenlåst macro. 

 

Macroens enkeltdele oplåses med den åbne hængelås.  

 

 

 
 

 

 
 

Printbaner: 

 

 

 

 
For loddeøer gælder, at de indre huller altid 

skal være ø 0,6 mm. Det er af hensyn til senere 

boring af huller. De er til at centrere boret. 

 

Øernes ydre diameter må meget gerne være 

over 2 mm. Så er der noget, loddetinnet kan få 

fat i.  

 

 

Når der tegnes baner, bør de være så brede som 

muligt. Det letter det senere arbejde. 

 

De skal jo også kunne bære den strøm, der skal 

løbe i dem. 

 

Brug mindst 1,5 mm. Der skal gerne bruges 

endnu bredere baner til Plus og Nul.  

 

Banebredde kan justeres før man tegner – eller 

bagefter. Man kan ændre ved at indtaste vær-

dier i de sorte ruder, eller ved at trække de små 

mærker til højre for tallene op eller ned. 

 

Der kan godt laves tyndere baner gennem IC-

øer, men det er meget vanskeligt at få til at fun-

gere ordentligt i processen. 
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Man kan gemme nogle defaultværdier bane-

bredder, og så hurtigt vælge banebredde og æn-

dre sine printbaner.  

 

Tilsvarende med Øer.  

 

 
 

Tegn Print-Baner: 

 

Vælg  

 

 

 

Brug mellemrumstasten til at ændre den måde, 

der tegnes. Vælg mellem ”først vandret”, ”først 

opad” – eller ”direkte”.  

 

 

Brug Ctrl til at vælge punkter off grid. 

 

 

 

 
 

På en bane er der en række blå markeringer.  

 

Disse kan man tage fat i og flytte, så banen kan 

tilpasses.  

 

Brug Venstre Mus. 

 

 

 

Med Højreklik på en af de blå markeringer, får 

man flere muligheder: 
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eller: 

 

 

 

Når en bane – eller flere - er 

valgt, kan man ændre deres 

bredde. 

 

Enten ved at trække op eller 

ned i markeringen til højre for 

tallet, der angiver banebred-

den. 

 

Eller klikke på en af de gemte 

værdier 

 

 

 

Banebredden skal passe til den strøm, der 

skal løbe i en bane. 

 

Bredden kan findes vha en calculator.  

 

Se Link: 

 
 

 

 
Se Link:  

 

Man skal indtaste strømmen, og kobber-bane-

tykkelsen.  

 

Denne er typisk 35 eller 70 um  

 

 

 

 

 

 

http://www.circuitcalculator.com/wordpress/2006/01/31/pcb-trace-width-calculator/
http://www.circuitcalculator.com/wordpress/2006/01/31/pcb-trace-width-calculator/
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Loddeøer kan også ændres. Man kan bestemme 

om de er runde, aflange osv.  

 

Bemærk specielt F12.  

 

Med F12 kan gøre en ø til en Through Pads 

 

Det er smart hvis der bruges lus, - og man bru-

ger ” test-funktionen ” 

 

 

 

.   
 

 

 

Smarte hjælpefunktioner: 

 

Sæt Origin.   

 

 

 

 

 

Træk den blå markering, eller højreklik et sted i udlægget.  
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Via, - gennemplettering, Lus  

 

 
 

Sprint Layout har en smart funktion, 

der kan bruges til at teste, om der er 

forbindelse til alle de stedet, der ønskes. 

 

Men som det ses på dette layout, er der 

et par steder, hvor der skal monteres en 

lus, en stump tråd, hvormed man kan ” 

hoppe over ” en eller flere baner. 

 

Her er der tegnet en tynd kobberbane i 

lag 1, altså oppe på komponentsiden. 

 

Men for at få forbindelse ned gennem 

hullet, skal loddeøen være en Trough 

Pad.   

 

 

 

Det gøres ved at markere øen, og trykke F12. 

 

 

 

 
 

Nu kan man vælge ” Test” – og følge banerne 

rundt på printet.  
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Tekst på silketrykket er vigtigt, fx til mod-

standsstørrelser, til at vise hvor plus er osv.  

 

 

Smart funktion: 

 

Brug Measure til at opmåle et print 

 

 

 

 

Smart funtion: 

 

Her er der tegnet en macro til FTDI-stikket til Arduino. 

 

Det er tegnet med øer, og der er tegnet omrids og sat tekst 

på i silke-laget. Sluttelig er delene låst sammen. Herefter 

fungerer de som 1 komponent, eller som en macro. 

 

 

 
 

Macroer kan gemmes i biblioteket 

File > Save as macro.  
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Afstand mellem baner / øer:  

 

 

 

  

Minimum afstand ved 230 Volt 

 

 
 

 

Opsummering & Tjekliste: 

 

Husk hjørner 
Strø kondensatorer rundt 
Øer 0,6 mm - bore med 0,9 mm og senere fx til 3 mm 
Banebredde minimum 1,5 mm.  
Lagene  ( kan slukkes / tændes mm. ) 
Baner minimum 1,5 mm.  ( adderes til default ! ) 
Øer, indre hul ø0,6  ydre noget større , forskellige former, Pad,  
Via med F12, Through pad.  
Grid  
Hoppe over bane,  
Hjørner til at klippe efter når der er ætset 
Se på " Test" 
Snap to grid  ( Ctrl - frigør )  Default Grid 2,54, evt. 1,27!! 

Skiftes grid, kan der forekomme unøjagtigheder.   kan hjælpe. 
Lås elementer sammen med hængelås !!  Evt. flytte dem før, ændre, og så låse sam-
men igen  
Roter 
Dubler med X2 
Gem Macroer 
Origo 
Lag kan vælges som aktiv, / slukkes og tændes ! 
Tekst og størrelse på komponenter 
Hjælp:  Fane " ? "  - vælg Index 
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 Udprintning:  Send det til mig, jeg tjekker, evt. printer papir-udgave ud,  
Når OK, samler jeg flere, og vi printer fælles for at spare på OH.  
 

Husk:  

 

Bane hen til kobberareal:  
Bane = induktion. Tynde kobberbaner har ca. 1 nH / mm. Jo bredere bane, jo 
mindre selvinduktion- 
 
Pad = kondensator i forhold til omgivelserne.  

 

 

Udprintning og tjek: 
 

 

Alle ”færdige” printudlæg sendes til mig – så jeg kan printe ud på papir med farve. Skal bruges til at 

se, hvordan printet ser ud i den virkelige verden !! 

 

Det er også mig, der samler forskellige print fra jer på samme film, og udprinter, fordi vi desværre 

ikke har så mange film !! 

 

 

Jeg hjælper også med belysning og ætsning. !! 

 

Belysning. 

 

Den udprintede film lægges på glaspladen sådan som den så ud på PC-skærmen. 

 

Træk dæk-foliet af en tilpasset stykke printplade, og læg den ned på filmen, med den fotofølsomme 

lak nedad. 

 

Luk låget og tænd for UV-lys i 3 minutter. 

 

 

Bor et hul i det ene hjørne til et stykke tråd, så printet senere kan sænkes ned i syren.  
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Printet skal nu fremkaldes.  

 

Al lak, der har fået UV-lys, skal vaskes væk.  

 

Der skal være stor kontrast mellem laklaget, og 

der, hvor lakken er opløst. 

 

Fjern med en finger det fedtede lag, der dæk-

ker printet. ( Ikke ridse ! ) 

 

 
Næsten fremkaldt printplade. 

 

Laklaget er vasket væk der hvor syren skal 

lege med kobberet.  

 
 

 

Skyl med vand, og monter et stykke tråd i et hjørne– så printet kan sænkes ned i Ætsevæsken. 

 

Hæld fremkalderen retur i dunken. – Den kan ikke tåle luft !! Den bliver stiv efter nogle timer. 

 

 

Der skal ætses i ca. 15 til 30 minutter, af-

hængig af syrens tilstand og temperatur. 
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Færdig ætset plade 

 
http://sfprime.net/pcb-etching/index.htm 

 

 

 

Herefter skylles, og der opryddes. 

 

 
Retur i værkstedet: 

 

Lakken, der beskyttede mod syren, skal fjernes med almindelig sprit. 

 

Herefter skal der bores huller, og endelig skal der påføres loddelak for at beskytte mod ilt. 

 

Går der mere end en time før der kan bores, kan man godt påføre loddelak, - så kan den nemlig nå 

at tørre inden der bores. Ellers vil borestøvet sidde fast i den våde loddelak. 

 

Hulstørrelser: 

 

Først bores med 0,9 mm i alle huller. 

 

Også de huller, der senere skal være større. Fx 1,3 mm til printklemmer, og 3 mm til skruer. 

 

Det er fordi, det er nemmere at centrere fx et 3 mm bor, når der er boret for !! 

 

Se dokument om lodning !! 

 

/ Valle 
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